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    WORKSHEETS 

 SPOKEN: 

 

A. Mention if the following statements are True or False. 

1. Vertical alignment helps to position the text within a section of a document relative to 

the left and right margins.                                                                                                        TRUE 

2. The thickness and style of the border remains fixed i.e., it cannot be changed.           FALSE 

3. We can add more buttons to the Quick Access Toolbar.                                                    TRUE 

4. By default the Format tab is present in the Ribbon.                                                            TRUE       

5. We can change the shape of the Word Art object by the shape Outline tool in the Format 

tab.                                                                                                                                         FALSE 

6. A cropped picture looks like the original picture, only the size is smaller.                      FALSE 

7. The watermark button adds a bright picture background to the document.                 FALSE  

 

 WRITTEN:  

 

A. Mention the shortest for the following operations: 

1. Cut : Ctrl+ X 

2. Copy : Ctrl + C 

3. Paste: Ctrl + V 

4. Italic : Ctrl + I 

5. Underline the highlighted Selection : Ctrl + U 

6. Undo the Last Action : Ctrl + Z 

7. Print : Ctrl + P 

 

B. Name the tool in each case. 

1. I help to quickly access commands like Undo, Repeat, Save Quick Access Tool Bar 

2. I am a text styling feature that is used to create text and to add more impact to the 

textWord Art Style 

3. I provide an outline to a picture Picture Border 

4.  I remove unwanted areas from a picture Crop 

 

C. Explain the step to do the following jobs: 

 

1. To adjust the Margins: 

STEP 1: Click on page Layout tab. 



STEP 2: Click on Margins in the page setup group. 

STEP 3: Select any option from the drop down list. 

 

2. To change the Page Orientation:  

STEP 1: Click on page Layout tab. 

STEP 2: Click on orientation in the page setup group. 

STEP 3: Select portrait or Landscape from the drop down. 

 

3. To change the paper size: 

STEP 1: Click on page Layout tab. 

STEP 2: Click on size in the page setup group. 

STEP 3: Select any available option from the drop down list. 

 

4. To add columns in a document: 

STEP 1: Click on page Layout tab. 

STEP 2: Click on columns in the page setup group. 

STEP 3: Select any option rom the drop down list. 

 

5. To insert Page Break in a document:  

STEP 1: Position the cursor where the page Break is to be inserted. 

STEP 2: Click on Insert tab. 

STEP 3: Click on Page Break in pages group. 

 

6. To add cover page to the document: 

STEP 1: Click on page Layout tab. 

STEP 2: Click on size in the page setup group. 

STEP 3: Select any available option from the drop down list. 

 

7. To add header and footer:  

STEP 1: Click on Insert tab. 

STEP 2: Click on Header in the Header & Footer group. 

STEP 3: Select any option from the drop down list. 

STEP 4: Design Tab is opened, from where Date &Time, Picture and clip art can be added. 

STEP 5: Selected Header is added with dotted line at the top of the document. Add text to 

be added in the Header. 

STEP 6: Click on Close Header and Footer to close the Header. 

 

8. To see the print preview of the document: 

STEP 1: Click on Microsoft Office Button. 

STEP 2: Select print from the drop down. 

STEP 3: Select print preview. 

 

9. To take a printout of the document: 

STEP 1:  Click on Microsoft Office Button.  

STEP 2: Select Print option. 

STEP 3: Click ‘Print’. This opens the print dialog box. 

 

 



D. Match the following :  

A                                                                                                              B 

1. Gutter Margin-------------------------------------------------- c. Binding 

2. Landscape------------------------------------------------------- a. Orientation 

3. Paper size-------------------------------------------------------- b. A3 

4. Newspaper------------------------------------------------------- e. Columns 

5. End of a page----------------------------------------------------- d. Page Break 

6. Cover Page--------------------------------------------------------- g. First page 

7. Text on top of each page--------------------------------------- f. Header 

 

E. Write (T) for True and (F) for False. 

 

1. The page setup Dialog box helps to change the margins in a document and to change the 

paper size.                                                                                                                                  TRUE 

2. In portrait mode the vertical edge of the paper is smaller than the horizontal edge. FALSE 

3. Columns give a paragraph look to the document.                                                              FALSE 

4. Page Break marks the end of a document.                                                                          FALSE 

5. Page Break can be added to a document using Home tab.                                               FALSE 

6. MS Word provides predesigned Cover pages.                                                                     TRUE 

7. Design Tab is opened when Header or Footer is added to the document.                    TRUE 

8. We should always see the preview of the document before printing it.                        TRUE 

9. Print helps to take the soft copy of the document.                                                             FALSE 

10. We can adjust the Top, Bottom, Left, Right, and Gutter margin of a document.           TRUE 

 

F. Fill in the blanks. 

 

1. Normally the cover page is the first page but we can place it anywhere in the document. 

2. A header is printed in the top margin and footer is printed in the bottom margin. 

3. Print preview displays on screen the way a document will print on paper. 

4. Portrait and landscape are two types of page orientation. 

5. Zoom helps to get a close up view of our document and zoom out helps to see more of 

the page at a reduced size. 

6. In the Print Dialog Box we click on print option to print the selected portion of the 

document. 

7. The document which is stored in the memory and is displayed on a screen is called soft 

copy. 

8. The copy of document which is printed on paper is called hardcopy copy. 

 

G. Who am I? 

1. I specify the distance of the text from right, left, top, and bottom edge of the 

paperMargin 

2. I specify the direction in which a document is displayed or printedOrientation  

3. I mark the end of the paper Page Number 

4. I am generally the first page of the document and give a professional look to the 

document Cover Page 

5. I help to add company’s name, address, topic , title, and page numbers at the top and 

bottom of every page of a document Header and footer 

6. I help to see exactly how the document would look before printing Print Preview 



H. Choose the correct answer.  

1. Page setup options are available in _______ tab. 

a. Insert  

b. Page layout 

c. Home 

d. View  

                         Ans: b. Page Layout 

 

2. In page Setup dialog box we can adjust the: 

a. Margin  

b. Size 

c. Layout 

d. All of these 

                     Ans: d. All of these 

 

3. The margins of a document can be adjusted by adjusting _____margins of the document. 

a. Left and Right 

b. Top and Bottom 

c. Gutter 

d. All of these 

                         Ans: d. All of these 

 

4. MS Word allows paper sizes of: 

a. A4 

b. A3 

c. Both A4 and A3 

d. None of these 

                       Ans: c. Both A4 and A3 

 

5. We can divide a document into ______columns. 

a. 1 

b. 2 

c. Multiple  

d. 3 

                         Ans: c. Multiple 

 

6. Page Break can be inserted in a document from _______ tab. 

a. Home 

b. Insert 

c. Page Layout 

d. View 

                          Ans:  b. Insert 

 

7. Cover page is generally the ________ page of the document. 

a. Last 

b. Second 

c. First 

d. Any 



                         Ans: c. First 

 

8. ______ tab is opened when Header/ Footer is added to a document. 

a. Ctrl + F1 

b. Ctrl + F2 

c. Ctrl + F3 

d. Ctrl + F4 

                        Ans: b. Ctrl + F2 

 

9. ______ Shortcut opens the Print dialog box. 

a. Ctrl +I  

b. Ctrl + A 

c. Ctrl + P 

d. Ctrl  + U 

                         Ans: c. Ctrl +P 

 

I. Answer the following questions. 

 

1. Rimsha was making a project for her Science Holiday homework. Her mother suggested 

that she gets the project bound. How can she give the extra space for binding? 

Ans: She can give the extra space for binding by gutters. 

         Gutter: Extra spaces allowed for binding. 

 

2. Tarun wants his article to be published in the newspaper; therefore he wants to type his 

document in the same style as in the newspaper. How can he achieve this? 

Ans: He can achieve this by adding columns. 

 

3. Krishna wants to take a printout on a A3 paper, what changes should she do that her 

document is typed on an A3 size paper. 

Ans: She will go to page size and select as per requirement. 

 

4. Sakshi wants the same title on all the pages of her document. She also wants page 

number to come automatically on all the pages of the document. How can she achieve 

this? 

Ans: She will add header and footer for both operation. 

 

5. Pradeep is too annoyed due to the wastage of paper and printer cartridge in his office. He 

now wants to check the document before taking a printout. How can he do this? 

Ans: He will check by print preview before printing. 

 

J. Write the purpose of the following. 

 

1. The Ribbon:  It is a graphical control element in the form of a set of toolbars placed on 

several tabs. 

2. Quick Access Toolbar: It is located above the Ribbon (top-left) and provides access to 

commonly used features and commands, such as save and Undo/Redo. 

3.  Word Art: It is a design feature of word to transform text into a colourful drawing. 



4. Clip Art: It is a collection of images from where we can choose an image and insert in our 

document. 

 

K. Write down the steps to do the following jobs. 

 

1. Add a catchy heading to your Birthday Card. 

Ans:  STEP 1: Click on the Insert Tab 

           STEP 2: Click word art button to open Word Art gallery. 

           STEP 3: Select any Word Art style from the gallery. 

 

2. Change the background colour of the document. 

Ans:  STEP 1: Click on Page Layout Tab. 

           STEP 2: Click on Page Colour Button. 

           STEP 3: Select any colour option. The selected colour is applied to the   

document. 

 

3. Give an impressive border to the document. 

Ans:  STEP 1:  Click on Page Layout Tab. 

           STEP 2: Click on ‘Page Borders’ Button. 

           STEP 3: Click on page Border tab. 

          STEP 4: Click a box setting, line style. 

          STEP 5: Click on OK. 

 

4. Give a textual watermark to your document. 

Ans:  STEP 1:  Click on Page Layout Tab. 

          STEP 2: Click on Watermark. 

           STEP 3: Click on Display watermarks. 

STEP 4: Select “picture watermark” to add picture as watermark. Select 

picture to be inserted. Click OK. 

STEP 5: We can select text to add text as watermark. Then we select the 

setting we want and click OK. 

 

5. Insert any shape in your document. 

Ans:  STEP 1: Click on Insert Tab. 

           STEP 2: Click on shapes button. 

STEP 3: Select any shape from the panel that appears and drag the cursor in 

the document. 

 

6. Give a border to your picture. 

Ans:  STEP 1: Click the picture. 

           STEP 2: Click on “Picture Borders” Button. 

          STEP 3: Click any colour. 

           STEP 4: Select any thickness. 

 

7. Add a picture to your document. 

Ans: STEP 1: Click the location where the picture is to be inserted. 

          STEP 2: Click the insert tab on the Ribbon. 

          STEP 3: Click the picture button 



          STEP 4: Locate the folder where picture that is to be inserted is present. 

          STEP 5: Select the picture to be inserted. 

          STEP 6: Click on Insert. 

 

8. Remove unwanted part from the picture. 

Ans: STEP 1: Click on the picture. 

         STEP 2: Select crop button from Format Toolbar. 

         STEP 3: Drag the Crop Handles to crop the picture. 

 

L. Choose the correct answer. 

 

1. Double clicking a picture selects it and makes the _____tab active. 

a. Insert 

b. Home 

c. Format 

d. View 

                       Ans: c. Format 

 

2. Page Borders can be given to the document from the ____tab. 

a. Insert 

b. Review 

c. Home 

d. Page Layout 

                         Ans: d. Page Layout 

 

3. Shapes can be added to the document from the _____ tab. 

a. Home 

b. Insert 

c. Page Layout 

d. View 

                       Ans: b. Insert 

 

4. When we open a new document the ___ tab is active. 

a. Insert 

b. Home 

c. Page Layout 

d. View 

                       Ans: b. Home 

 

5. The style of a picture can be changed by __________. 

a. Picture Shape Gallery 

b. Picture Style Gallery 

c. Picture Border 

d. Picture Effects 

                        Ans: b. Picture Style Gallery 

 

 

 



M. Answer the following questions. 

 

1. Can you change the location of the Quick Access Toolbar? If yes, them how? 

Ans: Click customize Quick Access Toolbar. It’s located on the right end of the Quick 

Access Toolbar. 

At the bottom of the list, choose either show below the Ribbon or show above the 

Ribbon as appropriate. 

 

2. What is WordArt? 

Ans: It is a design feature of word to transform text into a colourful drawing. 

 

3. What are the different methods for formatting a WordArt text? 

Ans: Different methods for formatting a WordArt text are shadows, glows, reflections, 3-

D rotations and text transformations. 

 

4. What are the different methods for formatting a picture? 

Ans: Different methods for formatting a picture are:  

a. We can change the style of the picture. 

b. Giving shape to a picture. 

c. Giving border to a picture. 

d. Inserting shapes, adding border, crop, special effects, colour, water mark etc. 

 

5. Can you make a drawing in MS Word? If yes, then how? 

Ans:  Click in your document where you want to create the drawing. On the Insert tab, 

click shapes. When you find the shapes you want to insert, double click to insert it 

automatically, or click and drag to draw it in your document. 

 

6. What is the Text Wrap Feature of MS Word? 

Ans: Text wrap is a feature supported by many word processors that enables you to 

surround a picture or diagram with text. The text wraps around the graphics. Text wrap is 

also called text flow. 

 

7. Suppose you want to insert your photograph in one of the documents. How will you go 

about it? 

Ans:  STEP 1: Click the location where the picture is to be inserted. 

            STEP 2: Click the insert tab on the Ribbon. 

            STEP 3: Click the picture button 

            STEP 4: Locate the folder where picture that is to be inserted is present. 

            STEP 5: Select the picture to be inserted. 

            STEP 6: Click on Insert. 

 

8. How do you search for an image in the large Clip Art gallery? 

Ans: Go to InsertImagesClip Art. Open search and choose where you want to look for 

images. 

 

9. What is the purpose of the Crop tool on the picture toolbar? 

Ans: Cropping refers to removals of unwanted areas from a picture. It gives more 

emphasis to the picture. 



 

 

10. How would you resize an image? 

Ans: Click the picture, shape, or WordArt you want to precisely resize.  

         Click the picture Format or shape Format tab. 

         Enter the measurements you want in the height and width boxes. 

 

 

 


